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This talk is for you if...

-

You are new to ALMA and have not yet had experience with the
relevant documentation...

You have not downloaded the ALMA Observing Tool (OT) or even
know where to get it.

You have a fabulous science case that will be essential to follow-
up with ALMA facilities...

You would like examples of science use cases for ALMA

You were familiar with Cycle 2 and wonder what Cycle 3
capabilities are now available and what changes will be made
before the Call for Proposals.

This talk will be available online for reference after this
workshop.
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Proposal Checklist

* Read relevant documentation (CfP, Primer, etc...)

* Create an ALMA account by registering at the Science
Portal (almascience.orq)

* Download the Observing Tool (OT) & related guides
* Prepare the Science Case (PDF file)

* Prepare Science Goals (sources, frequency & correlator
setup, integration times) within the OT

* Prepare the Technical Justification
* New Technical Justification inside each SG
* Make use of the Helpdesk & the Knowledgebase
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Cycle 3 Documentation & Timeline
4 )

* Call for Proposals

* ALMA Primer

* OT Guide

* ALMA Tech Handbook

Observing with ALMA

* Timeline for Cycle 3 A Primer for Early Science
* Mar 24 — Call for Proposals
* Apr 23 — Proposal Deadline
* Oct 1 — Start of Cycle 3
* Duration — 12 months
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* Read relevant documentation (CfP Guide, Primer, etc...)

* Create an ALMA account by registering at the Science
Portal (almascience.org)

* Download the Observing Tool (OT) & related guides
* Prepare the Science Case (PDF file)

* Prepare Science Goals (sources, frequency & correlator
setup, integration times) within the OT

* New Technical Justification inside each SG
* Make use of the Helpdesk & the Knowledgebase
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Proposal Checklist
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* Read relevant documentation (CfP Guide, Primer, etc...)

* Create an ALMA account by registering at the Science
Portal (almascience.org)

* Download the Observing Tool (OT) & related guides
* Prepare the Science Case (PDF file)

* Prepare Science Goals (sources, frequency & correlator
setup, integration times) within the OT

* New Technical Justification inside each SG
* Make use of the Helpdesk & the Knowledgebase

-~

Proposal Checklist



Downloading the ALMA OT

You are here: Home > Propesing » Observing Tool

Observing Tool

Proposing The ALMA Observing Tool (OT) is a Java application used for the preparation and submission of ALMA Phase | (observing proposal) and Phase Il
(telescope runfiles for accepted proposals) materials. Itis also used for preparing and submitting Director's Discretionary Time (DDT) proposals. The
current Cycle 1 release of the OT is configured for the Early Science Capabilities of ALMA as described in the Cycle 1 Call For Proposals. Note thatin
Road Map order to submit proposals you will have to register with the ALMA Science Portal beforehand.

About

Call for Proposals

Sensitivity Calculator .
) Download & Installation

DDT proposals The OT will run on most common operating systems, as long as you have Java 6 installed (see the troubleshooting page if you are experiencing Java
Obsenving Tool problems). The ALMA OT is available in two flavours: Web Start and tarball.
Web Start Download The Web Start application is the recommended way of using the OT. It has the advantage thatthe OT is automatically downloaded and installed on your

computer and it will also automatically detect and install updates. There are some issues with Web Start, particularly that it does not work with the Open
JDK versions of Java such as the "Iced Tea" flavour common on many modern Linux installations. The Sun/Oracle variant of Java should therefore be
Tarball Download Page  jnstalled instead. Ifthis is not possible, then the tarball installation of the OT is available.

OT Video Tutorials

Page

The tarball version must be installed manually and will not automatically update itself, however there should be no installation issues. For Linux users,

Troubleshooting
Observing
Data

Documents & Tools

Knowledgebase/FAQ Extensive documentation is available to help you work with the OT and optimally prepare your proposal:

e |fyou are a novice OT user you should startith the OT Quickstart Guide, which2akes you through the basic steps of ALMA proposal preparation.
User Services at
ARCs

e Audio-visualillustrations of different aspects ofthe OT can be found in the OT video tutorials. These are recommended for novices and advanced

users alike.

Helpdesk
- P e WMore in-depth information on the OT can belfgund in the User Manual, while copzise explanations of all fields and menu items in the OT are given in
= EU ARC O

the Reference Manual. These dwo documents are also available within the OT under the Help menu.
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Proposal Checklist

* Read relevant documentation (CfP Guide, Primer, etc...)

* Create an ALMA account by registering at the Science
Portal (almascience.org)

* Download the Observing Tool (OT) & related guides
* Prepare the Science Case (free-form PDF file, 4 pages)

* Prepare Science Goals (sources, frequency & correlator
setup, integration times) within the OT

* New Technical Justification inside each SG
* Make use of the Helpdesk & the Knowledgebase

-~
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* Read relevant documentation (CfP Guide, Primer, etc...)

* Create an ALMA account by registering at the Science
Portal (almascience.org)

* Download the Observing Tool (OT) & related guides
* Prepare the Science Case (PDF file)

* Prepare Science Goals (sources, frequency & correlator
setup, integration times) within the OT

* New Technical Justification inside each SG
* Make use of the Helpdesk & the Knowledgebase

-~

Proposal Checklist
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* Read relevant documentation (CfP Guide, Primer, etc...)

* Create an ALMA account by registering at the Science
Portal (almascience.org)

* Download the Observing Tool (OT) & related guides
* Prepare the Science Case (PDF file)

* Prepare Science Goals (sources, frequency & correlator
setup, integration times) within the OT

e >>>New Technical Justification inside each SG<<<
* Make use of the Helpdesk & the Knowledgebase
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Proposal Checklist




Tech Justification New for Cycle 3

A Observing Tool

Cycle3 Groundhog Day Test
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A sensitivity

Requested RMS over 2.4414062500000005E-4 GHz is 3.00 m)y

Achieved RMS over the total 351.56 MHz bandwidth is 111.80 u)y

Enter a Technical Justification for this Science Goal, paying special attention to the parameters reproduced below.

For a peak flux density of 30.00 mJy

, the achieved S/N is 10.0

, the achieved S/N is 894.4

For a continuum flux density of 100.00 mJy

[»

For a peak line flux of 30.00 m)y , the achieved S/N over 1/3 of the source line width ( 30.00 km/s /3 = 10.00 km/s ) is 26.1

Line width / bandwidth used for sensitivity 30.00 km/s / 731.92 m/s = 40.99

Dynamic Range: 33.33

Justify your requested RMS and resulting S/N for the spectral line and /or continuum observations.

For line observations also justify the bandwidth used for the sensitivity calculation.

Here would be the standard required justification of
the sensitivity parameters

r

\

There are separate sections for Sensitivity, Imaging and Correlator
Each requires its own 50+ word justification

Each comes with a summary of input information and details of how
it is construed to specify the program




Proposal Checklist

* Read relevant documentation (CfP Guide, Primer, etc...)

* Create an ALMA account by registering at the Science
Portal (almascience.org)

* Download the Observing Tool (OT) & related guides
* Prepare the Science Case (PDF file)

* Prepare Science Goals (sources, frequency & correlator
setup, integration times) within the OT

* New Technical Justification inside each SG
* Make use of the Helpdesk & the Knowledgebase
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www.almascience.org

Associated
Universities,nc

Atacama Large Millimeter/submillimeter Array

Search Site

Log in | Register | Reset Password | Forgot Account

| Welcome t the Science Portal at NO Ralsass of Scianoe
Science ey i " ..* i p & ‘ Verification data from the
. ; v y ALMA Long Baseline
Proposing . Campaign
Observing o
Announcement of intent to
Data

release a new installment of

Science Verification data
Documents & Tools

Knowledgebase/FAQ ALMA Cycle 3
Pre-announcement
This is the website for The ALMA Science Portal, served from one of the ALMA Regional Centers (ARCs) of the ALMA
ARCs partner organizations: ESO, NRAO or NAOJ. You may switch between the different instances of the portal through the ALMA Status Report:
« Helpdesk links to the appropriate ALMA partner at the top banner. Through this portal you can find details about the technical November 2014

capabilities of ALMA, how to propose for observing time, and how to access ALMA data. It includes links to all official
ALMA documents and tools, including those for preparing and submitting proposals and processing ALMA data. In order to
ccess some of the tools, users must register with the project and login to the portal via the links at the top banner.

ALMA Calendars
- Additional Scope for Long

= EU ARC Baseline Science

= NA ARC e three ARCs provides additional User Services, including a Helpdesk for all user queries. Each ARC ~ Verification Targets
EA ARC itional web pages with information on region-specific user services, such as visitor and student programs, 0, 201

| |

schools, workshopsiafinancial programs and public outreach activities. These are accessed via the links under the User  More...

Services at the ARCs in the left menu.
NRAO User Support Helpdesk NRAO Community Day at

ALMA Science Portal @ NRAO




| could use a hand...
Have no fear, the ALMA Helpdesk is here...

7 Knowledgebase

<< Science Portal fi Home

& News

Login
@,

Remember me

Lost password Login ‘

Knowledgebase

»» Knowledgebase .
. I General ALMA Queries (13)
__| General ALMA Queries (13)
| ] Can I submit a ticket in
Japanese?

| Early Science - Cycle 1 (31)

__| Resources & Observer Support

(12) | | How close can ALMA observe to

_ ) ) the Sun?
__| Project Planning (14)

_] ALMA Observing Tool (OT) (29)
_ Proposal Handling (5)

| Archive & Data Retrieval (4) ) Proiect p|anning (14)

__| Offline Data Reduction and/or

CASA (14) | ] what should I include for the

content of the Technical
Justification and in what format
should I submit it?

| ] Where can I find the online ALMA
observing simulator developed by
the University of Manchester?

__| Development Program (1)

Live Chat Software by Kayzko

_ I Resources & Observer
Support (12)

1 Early Science - Cycle 1 (31)

| | Can I use "breakpoints™ in ALMA

cycle 17 | ] How do I arrange a visit to one of

the ARCs?

| | Where can I find ALMA
documentation and manuals?

| ] The Cycle 1 Technical Handbook
has some gaps in its discussion of
ALMA receivers (SSB, 25B, DSB).
What else can you tell me about
them?

~ 1 ALMA Observing Tool (OT)
(29)

! Proposal Handling (s)

| | May I submit an identical proposal
to more than one category, e.q.
submitting a proposal on distant
galaxies both to cosmology and
to galaxy categories?

| ] What do I do if I can't get the OT
to work?

| ] How do I deal with targets with
unspecified coordinates in the

oT? | | Which category should I submit a

proposal on distant galaxies:
"cosmology/high-z" or
"Galaxies/Nuclei"?
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<= Science Portal i Home ® View Tickets ¢ Submit a Ticket 7 Knowledgebase @l News English (U.S.) [+

Account -
[Z] My Profile
Preferences

K Logout View Tickets , “ Submit a Ticket

R

» Knowledgebase

General ALMA Queries (14) = =

Early Science - Cycle 2 i_"—‘ Knowledgebase =': News

Early Science - Cycle 1 (31)

Resources & Observer h
Support (12)

Project Planning (14) Latest Updates

ALMA Observing Teool (OT)
(29)

El

No information available in this view
Proposal Handling (5)

Archive & Data Retrieval (4)

Offline Data Reducticn
and/or CASA (15)

Development Program (1)

Help Desk Software by Kayako Resolve

._m_ALMA Helpdesk @ NRAO (logged in view) .



Project - Observing T =
Edit View Tool Search Help

ew Proposal Ctr-N || 2 ‘E @

[1} New DDT Proposal Ctrl-D

Perspective 1

Open Project »
Save Ctrl-S
Save As...

( Spectral |"Spatial | Project |
Principal Investigator

(2]

=i Show ALMA Template Library
Use Project as Template »

SelectPI...

V] validate D

Submit Project

(2]

Preferences

Quit

Project Code None Assigned

validation | Validation History | Log |

Suggestion

Contextual
1. Please ensure you and vour co-Is are registered with the ALMA New
Science Portal Science
2. Create a new proposal by either: Proposal » : : ‘
® Se.lec.tm g File > Ne.w Prf;po sal Click on the overview steps to view the contextual help
@ Clicking on the & icon in the toolbar — -
@ Or clicking on this link

3. Click on the & proposal tree node and complete the relevant
fields.
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* Remember, you can resubmit as often as needed, but keep in mind
that the server is quite busy right before the deadline

e Standard and ToO proposals will be reviewed by the ALMA Proposal
Review Committee (APRC) and the ALMA Review Panels (ARP).

* All proposals will be subject to Technical Assessment by a selected
group of JAO and ARC experts.

* Proposals will be assessed on the basis of the overall scientific merit
of the proposed investigation and its potential contribution to the
advancement of scientific knowledge.

* Following approval by the Directors Council, the outcome of the
Proposal Review Process will be communicated to the Pls of all valid
submitted proposals, expected on or around July 29, 2015.

-~

Then what happens?
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Then what happens?

* If successful, you will be contacted about Phase || SBs — depending on
project, you may be able to create your own SBs by clicking
appropriate button (instructions will be provided) or someone from an
ALMA Phase Il Group may create them for you and contact you for
approval. Respond to them promptly.

* Then wait — dynamic scheduling means your Contact Scientist doesn’t
know when your project will run. As observations are made, updates
are shown in the Project Tracker at:

https://almascience.nrao.edu/observing/project-tracker

-~



For more info:

https://almascience.nrao.edu/

The Atacama Large Millimeter/submillimeter Array (ALMA), an international astronomy facility, is a
partnership of Europe, North America and East Asia in cooperation with the Republic of Chile.
ALMA is funded in Europe by the European Organization for Astronomical Research in the
Southern Hemisphere (ESO), in North America by the U.S. National Science Foundation (NSF) in
cooperation with the National Research Council of Canada (NRC) and the National Science Council
of Taiwan (NSC), and in East Asia by the National Institutes of Natural Sciences (NINS) of Japan in
cooperation with the Academia Sinica (AS) in Taiwan. ALMA construction and operations are led on
behalf of Europe by ESO, on behalf of North America by the National Radio Astronomy Observatory
(NRAO), which is managed by Associated Universities, Inc. (AUI), and on behalf of East Asia by the
National Astronomical Observatory of Japan (NAOJ). The Joint ALMA Observatory (JAO) provides
the unified leadership and management of the construction and operation of ALMA.




